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BAB III
ANALISIS DAN PERANCANGAN
3.1 Analisis.

Analisis merupakan suatu tahap pemahaman proses yang bertujuan untuk mengetahui proses apa saja yang terlibat dalam sistem dan berhubungan satu proses dengan proses yang lain.
Dari pemahaman proses tersebut maka dapat dilakukan suatu evaluasi dan usulan terhadap sistem yang ada, untuk dikembangkan lebih lanjut. Dengan demikian, dapat dikatakan bahwa tahap analisis merupakan tahap yang cukup kritis, sebab kesalahan pada analisis akan mempengaruhi tahap selanjutnya.
Sebelum  melakukan perancangan,  perlu melakukan analisis untuk mengetahui beberapa kebutuhan baik itu ditinjau dari segi fungsional ataupun dari segi interaksi.

3.1.1 Informasi Yang Ditampilkan.

Informasi yang akan ditampilkan dalam Animasi 3 dimensi pada Archicad ini adalah :

1. Menu Utama.

Berisi tampilan utama CD Interaktif yang didalamnya menampung informasi yang berkaitan dengan perusahaan pengembang dan tentang pemasaran produk rumah.
A. Profile.

Halaman ini menampilkan informasi mengenai latar belakang perusahaan seperti :

1. Visi dan Misi.

Halaman ini berisikan informasi mengenai visi dan misi perusahaan.

2. Sejarah

Halaman ini berisi informasi kapan perumahan ini berdiri.
3. Struktur 

Halaman ini berisi informasi mengenai struktur organisasi perusahaan. 
B. Produk

Halaman ini akan menampilkan visualisasi produk yang ditawarkan pada konsumen dengan animasi 3 dimensi. Adapun produk yang ditawarkan adalah :
1. Tipe 36 / 84.
Halaman ini menampil visualisasi produk bertipe 36 / 84. adapun visualisasi yang ditampilkan.
a. Seluruh bangunan

b. Halaman Depan.

c. Ruang Tamu.

d. Ruang Tengah.

e. Kamar Tidur Depan.

f. Kamar Mandi.

g. Kamar Tidur Belakang.

h. Halaman Belakang.

2. Tipe 42 / 90.

Halaman ini menampil visualisasi produk bertipe 42 / 90. adapun visualisasi yang ditampilkan.

a. Seluruh bangunan

b. Halaman Depan.

c. Ruang Tamu.

d. Ruang Tengah.

e. Kamar Tidur Depan.

f. Kamar Mandi.

g. Kamar Tidur Belakang.

h. Halaman Belakang.

3. Tipe 48 / 112.

Halaman ini menampil visualisasi produk bertipe 48 / 112. adapun visualisasi yang ditampilkan.

a. Seluruh bangunan

b. Halaman Depan.

c. Ruang Tamu.

d. Ruang Tengah.

e. Kamar Tidur Depan.

f. Kamar Mandi.

g. Kamar Tidur Belakang.

h. Halaman Belakang.

C. Keterangan

Halaman ini menampilkan informasi mengenai keterangan apa saja yang diperlukan dalam pemasaran produk. Adapun keterangan yang ditampilkan dalam halaman ini seperti :
1. Harga.

Halaman ini menampilkan informasi harga yang ditawarkan oleh pengembang.

2. Tunai.

Halaman ini menampilkan informasi mengenai syarat kepemilikan rumah untuk pembelian secara tunai.
3. KPR.
Halaman ini menampilkan informasi mengenai syarat kepilikan rumah untuk pembelian secara KPR ( Kredit Pemilikan Rumah ).

4. Fasilitas.
Halaman ini menampilkan informasi mengenai fasilitas yang ditawarkan oleh pengembang untuk konsumen.

5. Lokasi

Halaman ini menampilkan informasi mengenai letak atau lokasi dimana perumahan ini berada.   
D. Kontak


Menu kontak berisi tentang nama developer, alamat developer, dan nomor telepone yang dapat dihubungi.

3.1.2 Batasan Masalah.
Agar pembahasan masalah tidak keluar dari pokok permasalahan,  memberikan batasan masalah yang diamati yaitu :

1. Tidak membuat produk rumah secara detail, seperti : ukuran bahan yang digunakan, banyaknya bahan yang digunakan, dan harga bahan yang digunakan.

2. Hanya membuat 3 tipe produk rumah saja.

3. Produk yang dihasilkan berupa produk interaktif dan video animasi.
3.1.3 Analisis Kebutuhan.
Dalam tahapan analisis pembuatan CD interaktif ini, diperlukan suatu analisis terhadap perangkat yang akan dirancang. Adapun kebutuhan yang diperlukan dalam perancangan tersebut antara lain : 

1. 
Dukungan Personil / User
Perancangan  pembuatan CD interaktif pada intinya harus mengetahui karakteristik dari user / personil yang akan mengoperasikan perangkat aplikasinya. pembuatan CD interaktif ini dapat dioperasikan oleh pekerja perusahaan dan konsumen yang tertarik untuk memiliki  rumah. Karena CD intearaktif ini merupakan media produk rumah yang ditawarkan.

2. 
Fungsi pembuatan CD interaktif

Perancangan pembuatan CD interaktif ini, berfungsi sebagai suatu media pemasaran produk rumah yang ditawarkan oleh produsen atau developer. 

Seorang pengguna dapat mengoperasikan, menikmati, serta berinteraksi dengan media yang memanfaatkan atau menerapkan multimedia dalam suatu implementasinya. 

3. 
Kebutuhan Data

Pada proses aplikasi pembuatan CD interaktif di butuhkan data-data yang terlibat selama pemrosesan itu berlangsung. Dalam hal ini data yang terlibat adalah file – file objek,  nama file objek, dan fungsi dari objek-objek tersebut.
A. Informasi Perusahaan.

Kebutuhan data yang diperlukan mengenai informasi perusahaan seperti :
a. Visi dan misi perusahaan.

b. Kapan berdirinya perumahan ini.

c. Struktur Organisasi perusahaan.
d. Logo dari perusahaan.

e. Lokasi dari perumahan.
B. Informasi Pemasaran Produk Rumah.

Kebutuhan data yang diperlukan mengenai informasi pemasaran produk rumah seperti :
a. Harga dari produk rumah yang ditawarkan.
b. Syarat kepemilikan rumah baik itu pembelian secara tunai ataupun melalui KPR.

c. Fasilitas yang ditawarkan pada konsumen.

C. Informasi Produk Rumah.
Kebutuhan data yang diperlukan untuk informasi produk adalah :

a. Denah rumah yang digunakan dalam pembuatan animasi.
b. Foto rumah digunakan untuk membandingkan visualisasi 3D dengan visualisasi nyata..  

3.1.4 Sekilas mengenai ArchiCAD 9.0.
3.1.4.1.
Gambaran umum Tools.

Archicad adalah sebuah software disain arsitektur yang dirilis oleh perusahaan Graphisoft yang berpusat di Hongaria. Archicad di disain dan dikembangkan dengan menganut sistem teknologi virtual building, yang sangat membantu mewujudkan visualisasi 3 dimensi imajinasi  dalam merancang sebuah bangunan dengan cepat, akurat, dan realistis.

Secara khusus, ArchiCAD memang dibuat untuk memenuhi kebutuhan para arsitek dan mereka yang terlibat dalam dunia rancang-bangun untuk menghasilkan karya disain yang optimal. 

Namun saat ini, penggunaan ArchiCAD berikut teknologi virtual building-nya telah berkembang luas untuk memenuhi kebutuhan set properti gedung/bangunan di indistri film, iklan maupun game. Semua itu dimungkinkan karena fleksibilitas ArchiCAD yang dapat terintegrasi dengan baik dengan software pengolah animasi 3D lain yang umum digunakan, seperti 3DS Max, Maya, SoftImage, dan sebagainya.

3.1.4.2. Teknologi Virtual Building.

Virtual building merupakan konsep membuat suatu bangunan yang bukan sekedar menggambar, dalam sebuah sistem digital yang akan menyerupai dengan bengunan aslinya nanti. Harapan yang melatarbelakangi pengembangan sistem ini adalah meminimalisir kesalahan-kesalahan disain pada saat pelaksanaan pekerjaan kontruksinnya, karena pada dasarnya bangunan tersebut telah terbangun secara tiga dimensi dengan model ruang dan bentuk yang mendekati aslinya.

Bedanya dengan proses disain manual maupun penggambaran dengan software disain berbasis objek 2D atau bahkan dengan software 3D sekalipun yang bukan berbasis CAD, dengan  ArchiCAD, bekerja dengan elemen kontruksi yang sebenarnya. Pendek kata, dengan ArchiCAD akan membangun miniatur gedung yang disebut dengan Virtual Building, persis sama dengan gedung yang akan terbengun aslinya nanti.

3.1.4.3. Library dan Konsep Parametrik.
Sebuah inovasi lain dari ArchiCAD adalah kelengkapan library yang dimilikinya serta konsep parametrik dari objek library tersebut. Yang memberikan keluasan untuk mengubah ketinggian, ketebalan, material, dan banyak lagi parameter penyesuaian lainya hingga memudahkan membuat berbagai alternatif yang memperkaya desain.
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Gambar 3.1 Library Objek Tool
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Gambar 3.2. Contoh Konsep Parametrik elemen Jendela.

3.1.4.4. Tampilan User Interface
Tampilan antar muka pengguna ArchiCAD telah didesain dengan tampilan perangkat-perangkat kerja yang nyaman dilihat dan digunakan untuk bekerja serta memiliki ketepatan (presisi) dan tingkat akurasi yang tinggi. User interface dapat diatur dengan cara menggeser posisi ataupun memunculkan/ menyembunyikan bidang kerja dan kotak-kotak paletnya sesuai keinginan.
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Gambar 3.3. Tampilan User Interface ArchiCAD.

3.1.4.5. Bidang Kerja.
Secara garis besar bidang kerja ArchiCAD dibagi atas 3 jendela window utama yang dapat digunakan untuk bekerja, yaitu Floor Plan Window, Section/Elevation Window, dan 3D window, ditamah sebuah jendela Photorender Image yang dapat diakses dari menu Image > Photorender Projection untuk melihat hasil akhir proyek gambar yang akan ditampilkan sebagai sebuah gambar fotorealistik.

Yang harus di ingat dan di pahami adalah ketiga jendela utama di dalam bidang kerja archiCAD adalah saling terintegrasi sehingga ketika menggambar atau melakukan pengeditan objek pada salah satu jendela tersebut, maka akan secara otomatis mengubah tampilan di kedua jendela lain.
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Gambar 3.4. Tiga jendela utama yang saling terintegrasi.

A. Floor Plan Window.

Adalah jendela untuk menampilkan posisi denah dari bangunan yang rancang. Biasanya pekerjaan awal merancang sebuah gedung mulai dengan membuat denah terlebih dahulu. Pada dasarnya Floor Plan Window memiliki fungsi :

1. Menampilkan hasil disain sebagai sebuah gambar kerja arsitektural.

2. Sebagai sebuah lingkungan 2D yang interaktif dengan jendela tampak/potongan dan jendela 3D. 
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Gambar 3.5. Tampilan Floor Plan Window.

B. 3D Window.

Adalah lingkungan kerja yang digunakan untuk memvisualisasikan tiga dimensi proyek arsitektural dan sekaligus sebagai jendela untuk mengedit gambar secara tiga dimensi. 3D Window memiliki fungsi :

1. Pada tahap disain awal, akan sangat membantu untuk melihat bagaimana bangunan secara nyata atau tiga dimesi nantinya.

2. Pada tahap akhir produksi, gambar-gambar 3D yang akurat dan optimal dapat dihasilkan untuk keperluan cetak, presentasi, dan lain-lain.
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Gambar 3.6. Tampilan 3D Window
C. Section/Elevation Window . 
Adalah jendela yang bisa digunakan untuk menampilkan gambar maupun potongan dari gambar kerja.
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Gambar 3.7. Icon Section/Elevation Tool.

Jadi, dengan section/elevation tool ini dapat dengan bebas membuat gambar mapun potongan gambar kerja sebanyak yang dibutuhkan. Yang perlu diperhatikan adalah :

1. Jika melakukan editing pada elemen kontruksi di jendela ini, secara otomatis akan turut mempengaruhi pada jendela floor plan dan 3D.

2. Jika melakukan editing dengan menambah elemen 2D saja ( misal menambah garis, arsir, atau teks), tidak akan berpengaruh pada tampilan jendela floor plan dan 3D.
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Gambr 3.8. Tampilan jendela Section/Elevation Tool.

D. Model Picture Window.

Adalah jendela yang bisa digunakan untuk melihat hasil akhir proyek gambar yang dapat ditampilkan sebagai sebuah gambar photorealistik. Untuk membuat gambar ini dapat diakses dari menu Image > PhotoRender Projection. Atau klik icon PhotoRender Projection yang terletak pada toolbar.
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Gambar 3.9. Icon PhotoRender Projection di toolbar.
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Gambar 3.10. Tampilan Model Picture Window.

3.1.4.6. Tampilan Display dan Views.
Tampilan display dan views digunakan untuk mengatur tampilan gambar ketika bekerja dengan ArchiCAD, baik di jendela 2D maupun 3D. Penguasaan display dan view yang baik dapat memudahkan bekerja secara cepat dan presisi.
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Gambar 3.11. Tampilan Display dan Views.

Atau, dapat juga mengakses perangkat display dan view pada bagian bawah dari jendela 2D maupun 3D.

[image: image12.jpg]



Gambar 3.12. Perangkat Display dan Views.

3.1.4.7. Kotak Panel atau Palet.
Secara garis besar kotak panel dalam ArchiCAD dibagi atas 4 bagian utama, yaitu Tool Box, Infobox, Coordinate Box, dan Control Box. Untuk memunculkan atau menyembunyikan panel-panel box ini dalat dilakukan dengan memilih menu Window > Palette Layout. Sedangkan untuk memodifikasi bentuk dari panel-panel box, pilih menu Window > Palette Layout.
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Gambar 3.13. Kotak Palette Layout.
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Gambar 3.14. Tampilan modifikasi bentuk panel.

A. Toolbox.
Merupakan tempat seluruh perangkat elemen kontruksi berada. Secara fungsional, perangkat elemen-elemen kontruksi dalam toolbob dibagi ke dalam beberapa bagian.
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Gambar 3.15. Pengelompokan perangkat pada toolbox. 

B. Infobox.

Kotak panel ini digunakan untuk mengatur berbagai parameter (Setting) dari setiap elemen atau perangkat yang ada pada toolbox. Jadi, tampilan icon-icon pada pada panel ini akan selalu berubah-ubah sesuai dengan perangkat yang dipilih pada toolbox.
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Gambar 3.16. Contoh infobox elemen dinding.
C. Coordinate Box.

Kotak panel ini menampilkan informasi posisi kursor, baik dalam sistem koordinat Cartesian maupun Polar pada gambar kerja secara akurat. Ini sangat berguna untuk membantu memasukan ukuran dari gambar bangunan secara presisi ke dalam ArchiCAD.
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Gambar 3.17. Tampilan panel Coordinate Box.

D. Control Box.

Kotak ini berisi tool-tool yang telah didesain untuk membantu bekerja dengan cepat dan effisien.

Diantaranya adalah Relatif Contruction Methods yang akan membantu dengan cepat membuat objek tegak lurus dengan objek lain, membantu objek sejajar dengan objek lain, membantu objek yang membagi 2 objek lain tepat di tengahnya, dan lain-lain.
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Gambar 3.18. Tampilan panel Control Box.
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Gambar 3.19. Icon Relative Contruction Methods

3.1.4.8. Animasi.

Pada dasarnya ArchiCAD dirancang sebagai suatu perangkat gambar arsitektur yang mudah, cepat , dan akurat dengan menerapkan teknologi virtual building di dalamnya. Namun ArchiCAD memiliki fasilitas untuk pembuatan animasi yang cukup baik walaupun belum begitu maksimal dibandingkan dengan aplikasi 3D lain. Adapun pembuatan animasi yang dapat dilakukan dengan menggunakan ArchiCAD adalah Create Sun Study dan Create Fly-Through.

1. Camera.
Membuat objek kamera pada gambar bangunan dalam ArchiCAD. ArchiCAD dapat membuat lebih dari satu objek kamera, di mana setiap objek kamera berdiri sendiri. Dari objek kamera yang dibuat dapat melihat bangunan secara 3D. Tampilan 3D yang dihasilkan dari objek kamera sesuai dengan posisi objek kamera pada gambar. 

Adapun tool yang dapat digunakan untuk pembuatan kamera adalah
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Gambar 3.20. Camera tool.

Ketika icon camera tool diaktifkan, secara otomatis kotak panel info box akan menampilkan opsi pengaturan untuk elemen kamera.
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Gambar 3.21. Info Box Camera

Dalam info box ini  dapat mengakses dialog setting camera atau memilih jenis kamera yang akan digunakan.
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Gambar 3.22. Setting Camera
2. Sun Study.
ArchiCAD menyediakan sebuah fitur yang memungkinkan  membuat simulasi penyinaran matahari pada objek gedung.Hasil simulasi dapat ditampilkan langsung atau disimpan dalam file video dengan format video, image, dan animasi. Cara mengakses fasilitas ini dapat menggunakan menu Image atau dengan menekan tombol F10 pada keyboard.
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Gambar 3.23. Kotak Dialog Create Sun Study.

3. Fly-Through 
Gambar bangunan yang  dibangun dalam ArchiCAD dapat  dibuat animasi berjalan mengitari objek bangunan tersebut. Teknik animasi berjalan biasa disebut dengan istilah walkthrough. Teknik membuat animasi dalam ArchiCAD adalah susunan objek-objek kamera yang berurutan membentuk jalur animasi. Setelah semua kamera terseusun kita dapat menggunakan menu Create Fly-Through yang ada pada menu Image atau kita dapat menekan F11 pada keyboard.
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Gambar 3.24. Setting Create Fly-Through

Dalam penggunaan ke tiga animasi di atas ada beberapa hal yang perlu diperhatikan di antaranya sebagai berikut :

A. Format Output.

Dalam format output yang terdapat dua macam pilihan yaitu :

a. 3D Window.


Jika format output menggunakan 3D Window tidak memerlukan suatu pengaturan atau setting yang spesifik. Karena format 3D Window akan menghasilkan hasil akhir seperti apa yang di tampilkan pada 3D Window. Kualitas gambar yang di hasilkan dapat dilihat pada Gambar 3.6.

b. PhotoRendering Window.


Jika format output menggunakan PhotoRendering Window maka ada beberapa pengaturan atau setting yang harus dilakukan sebelum melakukan proses rendering. Pengaturan atau setting ini dilakukan untuk memberikan suatu kualitas image atau gambar yang memuaskan. Adapun pengaturan atau setting yang perlu diperhatikan dan langkah yang harus dilakukan adalah sebagai berikut :

· Untuk pengaturan atau setting dapat dilakukan melalui menu Image > PhotoRendering Settings.
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Gambar 3.25. Menu PhotoRendering Setting.

· Begitu masuk menu PhotoRendering Settings ada beberapa menu yang dapat di gunakan untuk menghasilkan format akhir dengan kualiatas yang baik.

1. Image Size & Effect.


Kotak image size & effect digunakan untuk mengatur ukuran gambar, resolusi gambar, kualitas, tampilan efek dan sumber pencahayaan serta bayangan dari gambar PhotoRendering.
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Gambar 3.26. Image Size & Effect.

2. Background.
Kotak background digunakan untuk mengatur latar belakang dari gamgar PhotoRendering. Untuk menampilkan warna ataupun gambar still image untuk menjadi latar belakang gambar bangunan ketika dieksekusi menjadi gambar PhotoRendering.
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Gambar 3.27. Background.

3. Brightness.
Kotak brightness digunakan untuk mengatur gelap-terang dari gambar PhotoRendering.
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Gambar 3.28. Brightness.

4. Parsial Rendering. 


Kotak parsial rendering digunakan untuk mengatur area yang ingin definisikan sebagai gambar PhotoRendering.
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Gambar 3.29. Parsial Rendering.

B. Format File.


Dalam kotak format file ada beberapa tipe file yang dapat digunakan, seperti format Quick Time, AVI, BMP, dan 3D. Pemilihan format file akan sangat berpengaruh pada hasil akhir yang di inginkan. Sebagai contoh disini membandingkan dua format file untuk mengetahui keunggulan dan kelemahan antara format AVI dengan Format BMP. 
1. Format AVI.

a. Keunggulan.

· Begitu selesai proses rendering hasil akhirnya dapat langsung dilihat karena sudah berupa sebuah produk video.

· Menghasilkan kualitas video yang cukup baik.

b. Kelemahan.

· Pada saat proses render tidak dapat boleh terhenti, jika sampai terhenti maka harus mengulang rendering dari awal lagi.

· Untuk kualitas yang sangat baik maka dalam penampilan video tersebut harus menggunakan hardware yang tinggi.

· Kapasitas yang diperlukan cukup besar untuk setiap rendernya.

2. Format BMP.

a. Keunggulan.

· Kapasitas yang diperlukan tidak sebesar menggunakan format AVI.

· Proses Render dapat dilakukan dengan cara bartahap, karena untuk setiap satu gambar hasil proses render mewakili setiap satu frame proses render yang dilakukan.

· Kualitas gambar cukup baik walaupun tidak sebaik hasil render AVI uncompress.

b. Kelemahan.

· Karena hasil render berupa image-image maka tidak dapat langsung dinikmati berupa produk video, jadi image-image tersebut harus digabung terlebih dahulu menggunakan aplikasi pengolahan video.

· Untuk menghasilkan kualitas video yang cukup baik dengan menggunakan image tersebut maka ukuran pixel yang digunakan harus minimal pada resolusi 1024 X 768 pixel. 

3.1.5 Pengumpulan Bahan.
Pengumpulan bahan dilakukan untuk memenuhi kebutuhan informasi dalam pembangunan CD yang akan dibuat, infomasi tersebut didapat dari :

A. Wawancara.


Pengumpulan bahan atau informasi dengan cara bertanya langsung pada pekerja dan yang bertanggung jawab di developer tersebut mengenai topik yang diangkat. Bahan yang dihasilkan dari hasil wawancara yaitu :

1. Profile Perusahaan.

a. Kapan mulai berdirinya perumahan ini.

b. Visi dan misi perusahaan.

c. Struktur organisasi perusahaan.

d. Logo perusahaan.

e. Lokasi dari perumahan berada.

2. Pemasaran Produk.

a. Harga produk yang dipasarkan.

b. Syarat kepemilikan rumah baik itu secara tunai atau melalui KPR.

c. Fasilitas yang ditawarkan oleh pengembang untuk konsumen.

3. Produk Yang Dipasarkan.

a. Denah Rumah.

b. Foto Rumah.   

B. Referensi.


Mencari bahan dari membaca buku-buku yang berkaitan dengan topik yang akan dibuat.

C. Browsing 


Mencari bahan atau informasi melalui media internet mengenai pemasaran produk rumah. 

3.2 Perancangan.

Dalam proses perancangan CD ini akan menampilkan informasi dalam bentuk interaktif teks, gambar, suara, video dan animasi. Pembangunan CD Interaktif sebagai pemasaran produk rumah adalah presentasi multimedia yang dapat berinteraksi dengan user (pengguna), dimana user dapat berpindah dari sebuah menu ke menu lainnya dengan lebih interaktif.


Secara visual Pembangunan CD Interaktif sebagai media pemasaran dalam bentuk penampilan informasi perusahaan ynag ada kaitannya dengan pemasaran dan juga visualisasi produk rumah secara 3D. Latar belakang menerapkan visualisasi animasi 3D untuk memberikan suatu sudut png yang berbeda dalam menampilkan produk rumah berbeda dengan cara penampilan produk yang ada sebelumnya.
3.2.1. Desain

Tahap desain ini dilakukan setelah data yang dikumpulkan telah mencukupi. Dalam tahap ini yakni menentukan daftar kebutuhan dari pembuatan animasi seperti teks, image, graphics, sound, video dan lain-lain. Elemen-elemen tersebut dapat dimodifikasi baik itu dengan cara digabungkan, ditambah atau dikurangi. 

Tahap desain awalnya dengan melakukan pembuatan menu utama yang digunakan sebagai penghubung ke menu yang lainnya.

Bentuk desain yang dibuat yaitu menitikberatkan pada kemudahan penggunaan, karena pengguna dari perangkat interaktif ini yaitu para konsumen yang berminat untuk memiliki rumah.

3.2.3 Pengembangan

Tahap ini merupakan tahapan utama pada langkah-langkah perencanaan. 

3.2.3.1   Format Desain CD (Compact Disk)
Keseluruhan desain awal sampai akhir CD ini menggunakan Macromedia Director MX. Dasar desain layoutnya akan menghasilkan citra statis dengan ukuran 800x600 pixel sebagai layout dari informasi dengan format file .dir dan .exe 

Setelah terbentuk citra statis kemudian menempatkan beberapa animasi yang bertujuan agar halaman tampak lebih menarik. Bentuk animsai hanya berupa pelengkap saja untuk mendukung tampilan visual yang lebih interaktif dan para pengguna lebih tertarik untuk melihat informasi yang ada didalam CD interaktif ini.

Ukuran citra statis yang berukuran 800x600 pixel di perlebar dengan menggunakan script sehingga tampilan fullscreen atau tampak memenuhi layar baik monitor untuk resolusi 800x600 pixel atau lebih. 

3.2.3.2.
Perancangan objek


Perancangan objek adalah perancangan elemen-elemen multimedia interaktif yang dibuat. Objek tersebut merupakan informasi yang disampaikan. Objek dapat berupa teks, gambar, suara, animasi, ataupun video.

3.2.4.  Struktur Navigasi.



Struktur navigasi memberikan gambaran link atau hubungan dari halaman yang satu ke halaman yang lain. Struktur navigasi biasa digunakan pada multimedia non-linier ( interaktif ), dan diadaptasi dari desain web [LJW01]. Gambar 3.39 struktur navigasi yang selengkapnya.
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Gambar 3.30 Struktur Navigasi

3.2.5.  Story Board

Story board  adalah suatu panduan kerja dalam proses pembuatan sebuah informasi yang berisi konsep gambar / desain dari informasi yang akan disampaikan, sehingga penerapan informasi tersebut menjadi suatu perancangan dan panduan yang jelas untuk implementasi.

Tabel 3.1 Story Board.
	Judul 
	”Intro”

	Visualisasi
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	Keterangan
	· Pertama Muncul muncul animasi kupu-kupu dengan latar bunga-bunga.

· Lalu muncul barner atas dan bawah. 

· Setelah muncul animasi text lalu muncul logo perusahaan. 

	Durasi
	10 detik

	Sound
	Ost. Ragnarok Online - Tread on the ground

	Logo
	Logo Bumi Adipura

	Animasi
	· Animasi Text

· Animasi Barner

· Animasi Kupu-kupu Terbang

	Text
	Hunian Nyaman di Bandung Timur

	Interaktif 
	-Tombol Skip


	Judul 
	”Menu Utama”

	Visualisasi
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	Keterangan
	· Begitu tombol skip yang ada pada intro makan akan tampil menu utama. 

· Dalam menu utama menampilkan informasi pembuka dan beberapa animasi.

	Durasi
	3  Detik

	Sound
	· Joe Satriani - (You're) My World

· Suara Klik Tombol

	Gambar 
	· Logo Bumi Adipura.

	Animasi
	· Animasi Rumah.

· Animasi Welcome.

· Animasi Tombol.

	Text
	· Hunian Nyaman di Bandung Timur

· Informasi  pembukaan.

	Interaktif 
	· Profile

· Produk

· Keterangan

· Kontak


	Judul 
	”Profile dan Visi & Misi”

	Visualisasi
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	Keterangan
	· Pada saat kursor mouse berada pada tombol profile maka akan muncul animasi teks profile berkedip.

· Begitu tombol Profile ditekan maka akan otomatis membuka sub menu Visi dan Misi .

· Sub menu Visi & Misi menampilkan informasi mengenai visi dan misi perusahaan..

	Durasi
	3 Detik

	Sound
	· Joe Satriani - (You're) My World

· Suara Klik Tombol

	Logo
	Logo Bumi Adipura

	Animasi
	· Animasi Rumah.

· Animasi Tombol
· Animasi Teks Visi & Misi

· Animasi Teks Profile.

	Text
	· Hunian Nyaman di Bandung Timur

· Informasi Visi dan Misi Perusahaan

	Interaktif 
	· Visi & Misi

· Sejarah

· Struktur

· Home

	Judul 
	”Sejarah”

	Visualisasi
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	Keterangan
	· Pada saat kursor melewati tombol sejarah muncul animasi tombol.

· Pada saat menekan tombol sejarah muncul informasi mengenai sejarah perusahaan.

	Durasi
	3 Detik

	Sound
	· Joe Satriani - (You're) My World
· Suara Klik Tombol

	Logo
	Logo Bumi Adipura

	Animasi
	· Animasi Rumah.

· Animasi Tombol

· Animasi Sejarah
· Animasi Teks Sejarah

· Animasi Teks Profile

	Text
	· Hunian Nyaman di Bandung Timur

· Informasi Sejarah Perusahaan

	Interaktif 
	· Visi & Misi

· Sejarah

· Struktur

· Home


	Judul 
	”Struktur”

	Visualisasi
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	Keterangan
	· Pada saat kursor melewati tombol struktur muncul animasi tombol.

· Pada saat menekan tombol struktur muncul informasi mengenai struktur perusahaan.

	Durasi
	3 Detik

	Sound
	· Joe Satriani - (You're) My World
· Suara Klik Tombol

	Logo
	Logo Bumi Adipura

	Animasi
	· Animasi Rumah.

· Animasi Tombol

· Animasi Struktur
· Animasi Teks Struktur

· Animasi Teks Profile

	Text
	· Hunian Nyaman di Bandung Timur

· Informasi Struktur Perusahaan

	Interaktif 
	· Visi & Misi

· Sejarah

· Struktur

· Home


	Judul 
	”Produk”

	Visualisasi
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	Keterangan
	· Pada saat kursor memasuki tombol produk muncul animasi tombol teks produk berkedip. 

· Begitu menekan tombol produk muncul 3 gambar rumah  beserta teks tipe rumah yang dapat digunakan untuk memilih produk rumah yang di inginkan.

	Durasi
	- 5 detik

	Sound
	· Joe Satriani - (You're) My World
· Suara Klik Tombol

	Gambar / Logo
	· Logo Bumi Adipura

· Gambar rumah

	Animasi
	· Animasi tentang visi & misi perusahaan

	Text
	· Hunian Nyaman di Bandung Timur

· Teks tipe rumah.

	Interaktif 
	· Tipe 36 / 84

· Tipe 42 / 90

· Tipe 48 / 112

· Home


	Judul 
	”Tipe 36 / 84 ”

	Visualisasi
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	Keterangan
	· Pertama  masuk tampilan ini  akan melihat denah rumah disebelah kiri dan gambar rumah disebelah kanan.

· Pada denah rumah dapat digunakan dengan menekan tiap ruang yang ada untuk melihat gambar tiap ruangan tersebut.

· Untuk gambar yang berada disebelah kanan dapat digunakan dengan menekan gambar tersebit untuk melihat video animasi.

	Durasi
	2 Detik

	Sound
	Joe Satriani - Moroccan Sunset

	Gambar / Logo
	· Logo Bumi Adipura

· Denah Rumah

· Gambar ruangan yang ada didalam rumah.

	Animasi
	· Animasi Tipe Rumah

· Animasi background
· Animasi Text

· Animasi Tombol

	Text
	· Hunian Nyaman di Bandung Timur

	Interaktif 
	· Tombol Tampak depan

· Tombol Ruang Tamu

· Tombol Ruang Tengah

· Tombol Kamar Tidur

· Tombol Kamar Mandi

· Tombol Kamar Tidur Utama

· Tombol Ruang Belakang

· Gambar tampak depan

· Gambar ruang tamu

· Gambar kamar tidur

· Gambar ruang tengah

· Gambar kamar mandi

· Gambar kamar tidur utama

· Gambar ruang belakang

· Tombol main menu.

· Tombol next

· Tombol Prev


	Judul 
	”Tipe 42 / 90 ”

	Visualisasi
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	Keterangan
	· Pertama  masuk tampilan ini  akan melihat denah rumah disebelah kiri dan gambar rumah disebelah kanan.

· Pada denah rumah dapat digunakan dengan menekan tiap ruang yang ada untuk melihat gambar tiap ruangan tersebut.

· Untuk gambar yang berada disebelah kanan dapat digunakan dengan menekan gambar tersebit untuk melihat video animasi.

	Durasi
	2 Detik

	Sound
	Joe Satriani - Moroccan Sunset

	Gambar / Logo
	· Logo Bumi Adipura

· Denah Rumah

· Gambar ruangan yang ada didalam rumah.

	Animasi
	· Animasi Tipe Rumah

· Animasi background
· Animasi Text

· Animasi Tombol

	Text
	· Hunian Nyaman di Bandung Timur

	Interaktif 
	· Tombol Tampak depan

· Tombol Ruang Tamu

· Tombol Ruang Tengah

· Tombol Kamar Tidur

· Tombol Kamar Mandi

· Tombol Kamar Tidur Utama

· Tombol Ruang Belakang

· Gambar tampak depan

· Gambar ruang tamu

· Gambar kamar tidur

· Gambar ruang tengah

· Gambar kamar mandi

· Gambar kamar tidur utama

· Gambar ruang belakang

· Tombol main menu.

· Tombol next

· Tombol Prev


	Judul 
	”Tipe 48 / 112 ”

	Visualisasi
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	Keterangan
	· Pertama  masuk tampilan ini  akan melihat denah rumah disebelah kiri dan gambar rumah disebelah kanan.

· Pada denah rumah dapat digunakan dengan menekan tiap ruang yang ada untuk melihat gambar tiap ruangan tersebut.

· Untuk gambar yang berada disebelah kanan dapat digunakan dengan menekan gambar tersebit untuk melihat video animasi.

	Durasi
	2 Detik

	Sound
	Joe Satriani - Moroccan Sunset

	Gambar / Logo
	· Logo Bumi Adipura

· Denah Rumah

· Gambar ruangan yang ada didalam rumah.

	Animasi
	· Animasi Tipe Rumah

· Animasi background
· Animasi Text

· Animasi Tombol

	Text
	· Hunian Nyaman di Bandung Timur

	Interaktif 
	· Tombol Tampak depan

· Tombol Ruang Tamu

· Tombol Ruang Tengah

· Tombol Kamar Tidur

· Tombol Kamar Mandi

· Tombol Kamar Tidur Utama

· Tombol Ruang Belakang

· Gambar tampak depan

· Gambar ruang tamu

· Gambar kamar tidur

· Gambar ruang tengah

· Gambar kamar mandi

· Gambar kamar tidur utama

· Gambar ruang belakang

· Tombol main menu.

· Tombol next

· Tombol Prev


	Judul 
	”Keterangan dan Harga”

	Visualisasi

	[image: image40.jpg]PROFILE vevenancan ] wonveAk

FASILITAS

Lokas!

KETERANCGAN
@ HOME







	Keterangan
	· Begitu tombol keterangan ditekan akan menampilkan informasi mengenai harga produk rumah. 

	Durasi
	3 Detik

	Sound
	· Joe Satriani - (You're) My World
· Suara Klik Tombol

	Gambar / Logo
	Logo Bumi Adipura

	Animasi
	· Animasi Rumah.

· Animasi Teks Harga.

· Animasi Teks Keterangan. 

· Animasi Tombol

	Text
	· Hunian Nyaman di Bandung Timur

· Daftar harga Rumah

	Interaktif 
	· Harga

· Tunai

· KPR

· Fasilitas

· Lokasi.

· Home


	Judul 
	”Tunai”

	Visualisasi
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	Keterangan
	· Begitu tombol Tunai ditekan akan menampilkan informasi mengenai syarat pembelian secara Tunai. 

	Durasi
	3 Detik

	Sound
	· Joe Satriani - (You're) My World
· Suara Klik Tombol

	Gambar / Logo
	Logo Bumi Adipura

	Animasi
	· Animasi Rumah.

· Animasi Teks Tunai.

· Animasi Teks Keterangan. 

· Animasi Tombol.

	Text
	· Hunian Nyaman di Bandung Timur

· Daftar harga Rumah

	Interaktif 
	· Harga

· Tunai

· KPR

· Fasilitas

· Lokasi.

· Home


	Judul 
	”KPR”

	Visualisasi
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	Keterangan
	· Begitu tombol KPR ditekan akan menampilkan informasi mengenai syarat kepemilikan rumah secara KPR.

	Durasi
	3 Detik

	Sound
	· Joe Satriani - (You're) My World
· Suara Klik Tombol

	Gambar / Logo
	Logo Bumi Adipura

	Animasi
	· Animasi Rumah.

· Animasi Teks KPR.

· Animasi Teks Keterangan. 

· Animasi Tombol

	Text
	· Hunian Nyaman di Bandung Timur

· Daftar harga Rumah

	Interaktif 
	· Harga

· Tunai

· KPR

· Fasilitas

· Lokasi.

· Home


	Judul 
	”Fasilitas”

	Visualisasi
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	Keterangan
	· Begitu tombol Fasilitas ditekan akan menampilkan informasi mengenai Fasilitas yang ditawarkan.

	Durasi
	3 Detik

	Sound
	· Joe Satriani - (You're) My World
· Suara Klik Tombol

	Gambar / Logo
	Logo Bumi Adipura

	Animasi
	· Animasi Rumah.

· Animasi Teks Fasilitas.

· Animasi Teks Keterangan. 

· Animasi Tombol

	Text
	· Hunian Nyaman di Bandung Timur

· Daftar harga Rumah

	Interaktif 
	· Harga

· Tunai

· KPR

· Fasilitas

· Lokasi.

· Home


	Judul 
	”Lokasi”

	Visualisasi
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	Keterangan
	· Begitu tombol Lokasi ditekan akan menampilkan peta lokasi perumahan berada.

	Durasi
	3 Detik

	Sound
	· Joe Satriani - (You're) My World
· Suara Klik Tombol

	Gambar / Logo
	Logo Bumi Adipura

	Animasi
	· Animasi Rumah.

· Animasi Teks Lokasi.

· Animasi Teks Keterangan. 

· Animasi Tombol

	Text
	· Hunian Nyaman di Bandung Timur

· Daftar harga Rumah

	Interaktif 
	· Harga

· Tunai

· KPR

· Fasilitas

· Lokasi.

· Home


	Judul 
	”Kontak”

	Visualisasi
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	Keterangan
	· Pada data kursor mouse berada pada tombol kontak maka akan muncul animasi tek kontak yang berkedip.

· Begitu menekan tombol kontak maka akan menampilkan informasi mengenai nama perusahaan, alamat perusahaan, dan nomor telpon perusahaan.

	Durasi
	5 Detik

	Sound
	Joe Satriani - (You're) My World

	Gambar / Logo
	Logo Bumi Adipura

	Animasi
	· Animasi Kontak

	Text
	· Hunian Nyaman di Bandung Timur

· Nama perusahaan, alamat perusahaan, nomor telpon

	Interaktif 
	· Home
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